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1 Customer Release Notes 

Introduction 

The Xerox® FreeFlow® Accxes® Controller Firmware Release 14.1 b 210 provides 
multinational software for the Xerox Wide Format 6604 Solution™, Xerox Wide 
Format 6605 Solution™, the Xerox 6204® Wide Format Solution and Xerox 6279® 
Wide Format Solutions. The languages supported are English, Deutsch, Espanol, 
Francais, Italiano, and Brazilian Portuguese. 

This document presents the following information about the FreeFlow Accxes 
Controller Release 14.1 build 210.  The document applies to FRX, LVX and UXC 
controllers and for simplicity they will simply be referred to as UXC. 

• Release deliverables 

• Recommended configurations 

• Installation procedures  

• Present supplemental information and known issues that are not mentioned in 
the published customer user documentation. 

• New features 
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Feature Keys 

Print and Copy Feature Keys are enabled on the UXC controller by loading the “OS 
Enablement” feature key.   

Additionally, the following functions will be unavailable until the appropriate 
feature key is loaded.   

• DGN printing is enabled with an “Other CAD” feature key. 

• JPEG 2000, PNG, BMP, and GIF printing is enabled with a Raster feature key. 

• DWF printing is enabled with the “AutoCAD” feature key. 

• Job Accounting Enables tracking media usage data for print, scan, and copy jobs.  
Account Management Tool, or some other external accounting tool, is used to 
assign User Id, Account Id, Printer Id associations, and then collects and tallies the 
stored data from the printers). 

• PostScript® – Enables the interpretation of Adobe® Postscript® 3™ and PDF 1.7 
files. 

• Disk Image Overwrite – Enables the security options for overwriting image data 
on the hard drive. 

• Scan-To-Net – Enables Scan to Mailbox, Scan to FTP, and Scan to Remote Printer 
features.  

• Scan-to-Print – Allows a scanned document to be printed to the system 
automatically as a proof copy. 

• Color Scanning key is only needed on the 6279 as this function is a standard 
function of the 6604 and 6605 solutions. 

• 9-D Speed key for printing on the 6279. 

• Speed Enhancement Turbo II – Enables 4 ips scan speed on the Wide Format 
Scan Solution 

• Speed Enhancement Turbo III – Enables 7.33 ips scan speed on the Wide Format 
Scan Solution. 
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Release Deliverables 

Xerox 6204 Wide Format Solution 

The following executable is provided for the Xerox 6204 Wide Format Solution.  

• FRX, LVX & UXC Controllers:  
FRX_LVX_UXC_6204_14_0b200.disk.bin (file size = 64,994,941 bytes) 

Xerox 6279 Wide Format Solution 

The following executable is provided for the Xerox 6279 Wide Format Solution and 
supports the Wide Format Scan System. 

• FRX, LVX & UXC Controllers:  
FRX_LVX_UXC_6279_14_0b200.disk.bin (file size = 64,676,155 bytes) 

Xerox Wide Format 6604/6605 Solution 

The following executable is provided for the Xerox Wide Format 6604/6605 Solution.  

• FRX, LVX & UXC Controllers:  
FRX_LVX_UXC_6604_6605_14_1b210.disk.bin (file size = 64,994,941 bytes) 
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Recommended Configurations 

The following table specifies the RAM requirements for the various systems and 
configurations supported by the FreeFlow Accxes controller. 

 FRX/LVX Controller UXC/UXC-N Controller 

System Min Recommend Max Min Recommend Max 

Any System with the following 
feature keys: 

AutoCAD 

Other CAD 

RASTER  

2GB 2GB 3GB 2GB 2GB 3GB 

Any System using TotalAccxes 2GB 2GB 3GB 2GB 2GB 3GB 

6204, 6604/6605 2GB 2GB 3GB 2GB 2GB 3GB 
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Release Installation 

This version of Accxes (14.1 b 210) requires OS Install CD version 4.3 or higher.  BSP 
Kernel revision 2.6.22.9-61.fc6 or later is also required.  Service is required to upgrade 
from earlier Accxes revisions. 

This version of Accxes has been tested with: 

• 6604/6605 printers running version 1.1.4 firmware and version 1.63 scanner 
firmware.   

• 6204 printers running version 1.1.4 firmware. 

• 6279 printers running version 1.00.15 firmware. 

 

Accxes Client Tools 

Download the file named “<Controller>_<Printer>_<Accxes_version>.disk.bin”.  A 
status sheet will be printed and indicate that the download was successful. 

Web Printer Management Tool 

Select Utilities > Upload > Upload File.  Use the Browse button to select the 
“<Controller>_<Printer>_<Accxes_version>.disk.bin”.  Click on the “Upload” button.  A 
printed status sheet will indicate that the download was successful. 

UNIX® 

Download the software using LPR with the following command line: 

 lpr –P printername  “<Controller>_<Printer>_<Accxes_version>.disk.bin” 

A status sheet will be printed and indicate that the download was successful. 
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New Features in 14.1 

None. 

New Features in 14.0 

Support for 6604 /6605 

This version of Accxes server now supports the latest multi-function systems from 
Xerox, the 6604 and 6605.  This product includes new scanner and scanning/copying 
modes. 

Scan to Network Service Split 

The “Scan to Network” Service previously available on the touch screen has been split 
into “Scan to FTP” and ‘Scan to Remote Printer” (Total Accxes) to provide more 
service specific functionality.  

Color Calibration for Scan to Remote Printers    

The Scan to Remote Printer service has the ability to calibrate for specific media and 
printers to provide enhanced color scanning.  The calibration is accomplished through 
the touch screen user interface on the 6604/6605 systems by pressing the “Calibrate” 
button and following the simple instructions. 

Preview    of Scanned Images on Touch Screen UI    

The touch screen UI can now display the scanned image as it is scanned in or view 
after the scan to zoom in to see the details.  These display features can be enabled 
and disabled by the system administrator for security conscious customers. 

A new checkbox has been added to the main screen of the Copy and Scan services to 
enable/disable the preview.  When enabled, the scanned image will be displayed 
scaled to fit on the Touch Screen UI as the document is scanned.  

On the Recall tab of the Copy and Scan services the user can recall the last scan by 
pressing the “Last Scan” button.  This brings up a viewer which allows the user to zoom 
and pan around the scanned image to ensure that the appropriate details were 
captured correctly. 



Xerox FreeFlow Accxes 

 

Customer Release Notes -8 - 

Job Reprint for Copy and Print Jobs    

From both the Web Printer Management Tool and the touch screen UI the user can 
now select a job and have it reprinted.  Jobs are selected from the “Reprint” tab on the 
main queue page OR the Job Information Service on the UI. 

Additionally, after selecting a single job the user can edit many of the job parameters 
to prior to reprinting.  This allows for a proof job to be submitted with one copy or on 
a smaller size and then reprinted at full size or for multiple copies. 

The Job Reprint feature can be enabled or disabled by the  Administrator.  When 
enabled, the administrator can specify how long jobs are kept available.  Job 
availability can be set for as little as one hour to as much as a week, provided there is 
sufficient disk space. 

Thumbnail View of Jobs in Job Queue 

The Web and touch screen UI’s can now display a thumbnail of the first page of the 
job.  The thumbnail if enabled by the administrator displays in the Job Queue with 
each rendered job.  A thumbnail is NOT available for display until the first page of the 
job has been rendered and is ready for printing. 

Initial SNMP Support 

Version 14.0 includes some initial support for SNMP V1/V2.  It can be configured from 
the Web Interface by the administrator.  Support for Printer Printer-Port-Monitor and 
Host Resource MIBs are present.  Traps can also be configured.  This support provides 
remote access to billing meters, media information, and toner levels from facilities 
management applications like Centreware Web.   
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Release Notes 

The following information supplements the 14.0 customer user guides. 

Internet Explorer® 6.0 

Internet Explorer 6.0 only does not display the Total Accxes preview image when 
using Web Printer Management Tool. 

Controller 

Stamp Does Not Appear 

If the user tries to upload a stamp files that contains an invalid format, or if the 
Accounting Mode is set to “Enabled”, no error message will be displayed. The Web 
Printer Management Tool screen will display a message that the file was uploaded 
successfully and the stamp’s filename will not appear in the “Printer Resident Stamps” 
list. To avoid this situation, set the Job Accounting mode to “Optional” before 
uploading stamps. The Web Printer Management Tool has no knowledge of the 
validity of any file that is sent to the printer. File validation and error handling is done 
on the printer by the FreeFlow Accxes controller. The Web Printer Management Tool 
only reports that the file was sent to the printer successfully. 

Scaling Interaction with “ANY” 

The media size “ANY” will select the best sheet size for an image to prevent clipping.  
If a user specifies a media size of “ANY” and a scale factor that makes the image too 
large for any sheet size and mismatch mode is set to scale, the controller will select 
the largest sheet size and scale the image to fit on it. If this is not the desired 
behavior, a specific sheet size can be selected, or the media mismatch mode can be 
set to QUERY. 

Margins May Cause Clipping 

If the margins (TOP, BOTTOM, RIGHT and LEFT) are set to a non-zero value (5mm is 
the default) then that amount of whitespace will be added to the image before 
placing it on the media and could cause part of the image to be shifted off the page, 
or clipped.  To correct this problem set the margins to 0. 

CGM Files and Folding 

Certain CGM files contain rotation commands which can confuse the system when 
folding.  If the title block is not visible or the plot is bypassed and not folded, change 
the title block location to obtain a correctly folded document. 
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Manual Feed 

Manual feed media source will be ignored when used with the Accxes Client 
Tools’ page composition feature 

Go to Accxes Client Tools > Job Option tab > Composition tab > Select Overlay Images 
> Media Source drop down menu.  Although “Manual Feed” is listed as a choice of 
media source for page composition jobs, the print job will be treated as if AUTO 
media source was selected.  If an appropriate roll of media is available, it will be 
printed on that media; otherwise, the job will query until the correct roll media is 
installed.  In addition, other Media Source selections will be treated as AUTO if an 
appropriate roll of media is available in a different roll. 

InstantAccxes 

When using InstantAccxes folders on an IPv6 network DNS server is recommended 
and you must reference the system directly as shown below: 

• Vista: Start>Run> \\<Controller Name> 

• Linux: smb://<Controller Name> 

InstantAccxes Folders not accessible from MAC® on IPv6 

InstantAccxes folders are not accessible to systems running MAC OS 10.4 or earlier 
versions on IPv6 networks. 

Web Printer Management Tool 

TotalAccxes copies Setting does not function 

When defining a remote printer for use with TotalAccxes there is a selection for 
“Copies” which is NOT applied to the job and should be ignored. 

Printer Queue – Main Web Printer Management Tool Screen 

The FreeFlow Accxes Controller supports a maximum of 120 active printer jobs in the 
queue and 8 active copy jobs.  If subsequent jobs are sent before the 128th prints, 
ports will refuse connections and there can be scan errors; when there are fewer jobs 
in the queue, the jobs can then be resubmitted or scanned. Additionally, completed 
jobs will be removed from the queue display immediately to make room for the newly 
submitted print jobs.  To avoid these issues, keep the number of active print jobs to 
under the 128 limit. 

Note 

More than 128 files can be sent from the Document Submit Tool as one print 
job, but all of the files in the print job must have printed before sending 
subsequent jobs, or the jobs will be refused. 

German users only 

Zum Drucken von Etiketten mit Umlauten DRUCKERVORGABEN > DRUCKER-
EINSTELLUNG > Plot-Etiketten wählen. Anschließend im Dropdown-Menü für Fonts 
einen der folgenden Fonts wählen: HP2 Stick Font Latin - 1 oder HP2 Stick font Latin - 
1 – Proportional. 
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Large Scaling Factors 

Images set to scale beyond the largest installed roll will not scale beyond the largest 
width unless a specific roll is selected, a specific page size is selected, or mismatch 
mode is set to something other than scaling. This is a behavior that has changed from 
previous releases (prior to 9.0). 

For example: The largest roll installed is 36". Scaling is set to 999%. Submit an ARCH 
E sized drawing (Media Size = Any, Mismatch = Scaling). The drawing will not be 
scaled. 

In order for the output to exhibit the desired scaling factor, one of the following 
conditions must be met: 

What to do: 

Set Mismatch Mode to Substitute  

• Request a Media Size of ARCH E via Web Printer Management Tool, ACT, or the 
Driver 

• Request a Media Size 36" Roll via Web Printer Management Tool, ACT, or the 
Driver 

HPGL Page – End of File 

If the files are streamed via any port on the system, these are treated as a single job 
and no reset is done between them.  However, if one uses the LPD protocol to send 
the files one at a time, the effect is that the printer is reset after each job. If the 
“Reinitialize after EOF” is set to be on, the FreeFlow Accxes firmware will reset the 
printing parameters after each plot file that is received by a serial port or a parallel 
port. To reset the HPGL parameters on the Web Printer Management Tool, select 
Printer Defaults > Emulations > HPGL.  Click on the box in front of “Reinitialize after 
EOF”.  Click on the “UPDATE PRINTER” button. 

Default PostScript Page Size 

If a PostScript job does not specify a page size (either by using a compatibility 
operator such as “letter”, or “a4”, or by using the setpagedevice operator /PageSize 
parameter), the page size used is the one specified by the Default PostScript Page Size 
parameter available via the printer user interface, or via the Web Printer Management 
Tool. 
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“Printer has been updated” Message 

If the user presses the “UPDATE PRINTER” button without actually making changes 
first, the Web Printer Management Tool will still return a message that the printer was 
updated.  The Web Printer Management Tool cannot distinguish a page that has 
been modified from one that has not been modified.  This is because of the 
“stateless” nature of the http protocol and the fact that no events are generated 
(html) when text values are entered or items are selected. When the “UPDATE 
PRINTER” button is pressed, all the data on the form is gathered and sent to the 
server.  If the data is valid, the printer is updated and “The printer was updated 
successfully.” message is returned.  If inappropriate data is sent, an error message is 
returned.  To verify valid changes to printer settings, a test print can be printed to view 
the changed settings. 

Scan to Print and Margins 

When performing a scan-to-print operation the scanned image is printed using the 
current printer processing defaults including margins.  If the image scanned is exactly 
the width of the paper, then the processing default margins should be set to zero to 
prevent the image from being clipped or placed on a larger sheet of paper. 

Scaling Shaded Documents 

Scaling documents with error diffused shaded areas should be done in a photo mode 
to produce the best image quality.  Line mode tends to exaggerate the shading dots 
making them more visible. 

Disk Image Overwrite 

Overview 

The Disk Image Overwrite feature has two operations: Immediate and On Demand.  
The immediate operation overwrites image data on the hard drive immediately after 
it is no longer needed (i.e. When the page has printed).  The On Demand operation 
cleans the entire disk.  Both On Demand Image Overwrite and Immediate Image 
overwrite feature are configured by the system administrator, assuming that the 
system administrator password is set to a non-zero value. 

Algorithm 

The overwrite algorithm for both IIO and ODIO conforms to the U.S. Department of 
Defense Directive 5200.28-M (Section 7, Part 2, paragraph 7-202), and is common to 
all WorkCentre/WorkCentre Pros and Accxes controllers.  

The algorithm for the Image Overwrite feature is: 

1. Pattern #1 is written to the sectors containing temporary files (IIO) or to the 
entire spooling area of the disk (ODIO). (hex value 0x35 (ASCII “5”)). 

2. Pattern #2 is written to the sectors containing temporary files (IIO) or to the 
entire spooling area of the disk (ODIO). (hex value 0xCA (ASCII compliment of 5)). 

3. Pattern #3 is written to the sectors containing temporary files (IIO) or to the 
entire spooling area of the disk (ODIO). (hex value 0x97 (ASCII “ú”)). 
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4. 10% of the overwritten area is sampled to ensure Pattern #3 was properly written. 
The 10% sampling is accomplished by sampling a random 10% of the 
overwritten area. 

Note 

See Online Help in Web Printer Management Tool for more details about using 
the Image Overwrite feature. 

 

Touch Screen for 6279/6604/6605 Specific Notes 

Overview 

This section is clarification to the existing documentation available for the Touch 
Screen UI which is used on the 6279 and 6604/6605 systems. 

Timer Reset Button 

This button will reset the timer value to the previous setting, NOT to the factory 
default setting. 

Shared Settings 

Many of the setting for Scan-to-Mailbox Scan-to-Remote-Printer and Scan-to-FTP are 
shared and so many of the settings made on one will stay when selecting the other. 

Can’t interrupt multi-page/set operations 

When creating a collated copy set or a multi-page scan file you cannot leave the 
Service to enter another service like machine info to change administration settings.  
To allow the user to do so would force an abort of the current scanned job or 
potentially change a setting which should have applied to all pages and so produce an 
inconsistent set. 

Managing Multi-page document sizes 

When creating a multi-page document it is important to use an appropriate resolution 
for the application.  A 600 dpi scan in full color is 38MB per inch (for 36” wide doc) 
and even with JPG compression will create files which quickly approach or exceed 
1GB.  Unless the application warrants a high resolution scan, it is recommended that 
200-300 dpi be used or limit the number of pages to keep file sizes manageable. 

Speeding up Remote Print Times 

When scanning a document to a remote printer it is important to use an appropriate 
resolution for the application.  A 600 dpi scan in full color will take significantly longer 
to process than a 200 or 300 dpi scan.  Unless the application warrants a high 
resolution scan, it is recommended that 200-300 dpi be used to increase productivity.  
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Installing and removing feature keys 

The 6279 and 6604/6605 systems must be in an idle state, not in a power-saving 
state when installing or removing feature keys.  In a power-saving state some 
components are powered down and cannot respond to feature key changes. 

Any Sheet page sizes 

When submitting a job where the media size is set to “ANY_SHEET” all standard page 
sizes will be used to identify a good fitting sheet.  Standard page sizes include all 
ANSI, ARCH, ISO A, ISO B, 30x42, 17x25, 22x36 and extended ISO sizes like 
297x1189, 297x841, 420x841, 594x1189, 841x2378. 

Changing settings on Instant Accxes folders 

When settings are changed on Instant Accxes folders, the folder usually needs to be 
re-shared to the network.  This may cause InstantAccxes folders which are open on 
client workstations to become invalid until the user closes the folder and re-opens it. 

Printing Custom Size Documents  

When printing non-standard size documents on the 6279 or 6604/6605, setting 
media mapping to “Any_roll” and setting mismatch mode to “Scale” produces the 
best results and prevents clipping. 

Web Printer Management Tool Reports Out of Toner Until Next Job 

On the 6279 and 6604/6605 if an out of toner condition occurs the Web Page will 
report the IOT status as out of toner until the next job is processed even if toner is 
loaded into the system.  The printer User Interface will report it correctly. 

TotalAccxes prints extra media to an Accxes driven printer 

When submitting large prints (ARCH E) via TotalAccxes to an Accxes driven printer it 
may produce an oversize print. 

“Please Wait” Message 

Occasionally when inserting one document immediately after another the printer user 
interface will display a “please wait” message until it is ready for the document.  If this 
message remains displayed for more than a few seconds, remove the newest 
document and re-insert to begin your scan. 

Copying ARCH-E size prints 

To maximize copying of ARCH-E size prints always copy them using the preset output 
format ARCH-E. When copied in synchro mode it is likely that ARCH-E documents will 
scan as 1220mm and will incur unneeded pauses between printing pages. The 6204 
IOT will pause between pages which are greater than ARCH-E (48 inches 1219 mm) in 
length for the fuser to come all the way back to full temp even if it is in the nominal 
fuser temperature range. 
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Sluggish Response While Scanning 

Occasionally under heavy load, the system, especially the User Interface, has 
been seen to respond slowly.  Response times usually speed up once the active 
jobs are completed.  If they do not a reboot of the system will restore proper 
operation. 

6604/6605 Specific Notes 

Scanner Fails to Accept Document 

If the scanner fails to accept and scan a document and does NOT display an 
error message it is necessary to open and close the scanner to reinitialize it for 
continued operation.  The scanner may take up to 10 seconds to initialize after 
closing. 

Copy Template Viewing 

When attempting to view a copy template with “Blue Line” as the original type 
the system will shutdown.  Any other original type will be displayed correctly. 

GFI Finishing Specific Notes 

Title-Block Icons 

The title block icons in the copy service show page orientation for face down 
scanning, but the 6604/6605 scanner is a face-up scanner.  To properly orient 
the copy document it must be flipped left-to-right from the title-block image 
on the UI.  If the user is scanning a document with a title-block in the lower 
right corner, the UI image selected must have the dashed title-block in the 
lower left corner. 

Gera Mondial B6 

Due to end of roll conditions or roll switch conditions, the system may appear to be 
hung or unresponsive.  The system can be reengaged simply by pressing the green 
folder reset button on the folder. By pressing the reset button, the system will begin 
again with the pages currently queued. Enhancements have been made to the system 
to allow for the reset as expected.  

Windows® 2008 security settings and TotalAccxes 

 

When using TotalAccxes on Windows 2008 servers, you must make some security 
setting changes to allow for the configuration of remote destinations. One of the 
following will work. 

1. Enable scripting. 

a. Go to Tools->Internet Options->Security 

b. Click on 'Custom level...' for the 'Internet' security zone. 
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c. Scroll down until you reach the category 'Scripting' and set 'Active Scripting' 
to enabled. 

2. Add the site to the trusted sites zone 

a. Navigate to the page you wish to allow to work 

b. Go to File->Add this site to->Trusted Sites Zone 

3. Disable the Internet Explorer Enhanced Security Configuration 

a. Open the Server Manager 

b. Click on 'Configure IE ESC' 

c. Turn off IE ESC for either Administrators or Users as seen fit. 
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Customer Issues Resolved 

The following issues were resolved in 14.1 build 210. 

Issue  Description Problem Resolution 

SPAR#  705162484 – 6279 
PS/PDF file doesn’t select 
correct roll 

When roll 3 or 4  is specified for 
a PS/PDF file on a 6279, the roll 
request is ignored. 

The PS/PDF interface was updated to 
allow 4 rolls and 2 trays in the 6279 
configuration. 

SPAR#  694448103 – 
Rendering setting in 
copy>Advanced cannot be 
saved 

The rendering setting in copy 
mode was allowed to change, 
but would not be remembered. 

Fix UI system to save rendering setting 
for copy mode. 

SPAR#  941696583 – 
6604/05 scanner doesn’t 
scan after upgrade to 1.63 

After updating to scanner 
version 1.63 the scanner 
becomes inoperable due to 
enhanced range checking. 

Added scanner diagnostics which allows 
the CSE to reset NVM values and adjust 
lead and trail edge registration. 

 

The following issues were resolved in 14.0 build 162. 

Issue  Description Problem Resolution 

SPAR#   529003086 – 
JBOSS error with Web 
Printer Management Tool 

The Web interface was not 
properly handling connections 
from browser applications which 
did not identify themselves.  In 
this case a custom application 
which polled Web pages for 
information. 

The Web interface now handles browsers 
which do not identify themselves. 

SPAR#  067213713 – 
Some parts of PDF file not 
printed correctly 

The postscript interpreter was 
not displaying certain parts of 
the image correctly. 

A modification was made to allow more 
of the interpreter settings to be adjusted 
at run-time.  This adjustment can be 
enabled or disabled by service using 
downloadable files. 

SPAR#  842053501 – 
Changing the PDF 
optimize setting on the 
510 UI caused the system 
to crash. 

Internal code issue with handling 
this legacy switch. 

The internal problem was addressed 
which prevents the system from crashing. 
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Issue  Description Problem Resolution 

SPAR#  696285405 – 
Paper series SPA1 does not 
work on touch-screen UI. 

The text for the 620mm roll was 
not included in the display list for 
this screen. 

620mm paper was added to the list and it 
now displays correctly. 

SPAR#  549518944 – CGM 
line types don’t match 
references 

Boeing identified a couple line 
types which did not match the 
current accepted styles. 

The line types have been updated to the 
currently accepted styles. 

 

 The following issues were resolved in 14.0 build 200. 

Issue  Description Problem Resolution 

SPAR #  691800243, 
381685353, 236038684 – 
510 printer with folder 
hangs displaying “printing” 
message. 

The 510 IOT occasionally was 
not properly starting a print cycle 
when a folder was attached. 

The Accxes server now detects this 
situation and will restart the print cycle 
with the IOT to allow printing to resume 
automatically.  Please note, the folder 
should be powered on LAST to ensure 
proper functionality of this fix. 

SPAR #  299676173 – not 
able to plot certain file 
correctly. 

When rotating this HP-GL file 
certain raster elements were not 
properly handled. 

These elements are now rotated correctly.  
System Default > Transform>Single Bit 
Scale Mode must be set to “Fast” or “Line 
Optimized” for scaling to be correct.  

SPAR #  970701013 – 
Problem creating sets build 
with Wide Format Scan 
System 

When creating sets with 
documents which had to be 
rotated using the Wide format 
Scan System could cause 
occasional crashes. 

Rotation code corrected. 

SPAR #  410023344, 
133783352, 787891316,– 
Wide Format Scan System 
won’t come out of power 
save 

The FTP server would cause a 
crash if performing too many 
directory operations.  This is 
typical if a mailbox polling 
application (ACT/DRT, Q-Series) 
is allowed to run for several days. 

Corrected FTP directory routine. 

SPAR #  839869848 – 
Plotter hung randomly 
building sets 

Same FTP issue as above. Corrected FTP directory routine. 

SPAR #  051482065 – 
Degenerate ARC in CGM 
not printing correctly. 

A CGM arc of zero degrees was 
printing too long. 

Corrected drawing routine to properly 
draw degenerate CGM arc. 

 

 



 
 

  

 


